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Copyrights

The Motorola Solutions products described in this document may include copyrighted Motorola
Solutions computer programs. Laws in the United States and other countries preserve for Motorola
Solutions certain exclusive rights for copyrighted computer programs. Accordingly, any copyrighted
Motorola Solutions computer programs contained in the Motorola Solutions products described in this
document may not be copied or reproduced in any manner without the express written permission of
Motorola Solutions.

© 2017 Motorola Solutions, Inc. All Rights Reserved

No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated
into any language or computer language, in any form or by any means, without the prior written
permission of Motorola Solutions, Inc.

Furthermore, the purchase of Motorola Solutions products shall not be deemed to grant either directly
or by implication, estoppel or otherwise, any license under the copyrights, patents or patent
applications of Motorola Solutions, except for the normal non-exclusive, royalty-free license to use that
arises by operation of law in the sale of a product.

Disclaimer

Please note that certain features, facilities, and capabilities described in this document may not be
applicable to or licensed for use on a specific system, or may be dependent upon the characteristics of
a specific mobile subscriber unit or configuration of certain parameters. Please refer to your Motorola
Solutions contact for further information.

Trademarks

MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or
registered trademarks of Motorola Trademark Holdings, LLC and are used under license. All other
trademarks are the property of their respective owners.

European Union (EU) Waste of Electrical and Electronic Equipment (WEEE)
directive

== The European Union's WEEE directive requires that products sold into EU countries must have
the crossed out trash bin label on the product (or the package in some cases).

As defined by the WEEE directive, this cross-out trash bin label means that customers and end-users
in EU countries should not dispose of electronic and electrical equipment or accessories in household
waste.

Customers or end-users in EU countries should contact their local equipment supplier representative or
service centre for information about the waste collection system in their country.
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Contact Us

Motorola Solutions Support Center
The Solutions Support Center (SSC) is the primary Motorola Solutions support contact. Call:
» Before any software reload.

» To confirm troubleshooting results and analysis before removing and replacing a Field Replaceable
Unit (FRU) and Field Replaceable Entity (FRE) to repair the system.

For... Phone
United States Calls 800-221-7144
International Calls 302-444-9800

North America Parts Organization

For assistance in ordering replacement parts or identifying a part number, contact the Motorola
Solutions Parts organization. Your first response when troubleshooting your system is to call the
Motorola Solutions SSC.

For... Phone

Phone Orders 800-422-4210 (US and Canada Orders)

For help identifying an item or part number, select
choice 3 from the menu.

302-444-9842 (International Orders)

Includes help for identifying an item or part number and
for translation as needed.

Fax Orders 800-622-6210 (US and Canada Orders)

Comments

Send questions and comments regarding user documentation to
documentation@motorolasolutions.com.

Provide the following information when reporting a documentation error:
» The document title and part number

» The page number with the error

* A description of the error

We welcome your feedback on this and other Motorola Solutions manuals. To take a short, confidential
survey on Motorola Solutions Customer Documentation, go to docsurvey.motorolasolutions.com or
scan the following QR code with your mobile device to access the survey.
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About Affiliation Display User Guide

Affiliation Display is an application that displays the association of a radio with a talkgroup and a site,
and information about conventional channels, console sites, and consoles. It enables you to monitor
how radio users travel between different sites in a zone and how they communicate with other
members of their assigned talkgroup and those outside of their talkgroup.

What Is Covered In This Manual?

This manual contains the following chapters:

« Affiliation Display Description on page 21, presents an overview of Affiliation Display. It also
compares this application to ZoneWatch.

» Affiliation Display Operation on page 25, describes how to access Affiliation Display and use the
viewers to access the console site, conventional channel, radio, site, and talkgroup information.

« Affiliation Display Reference on page 39, describes the elements of the Affiliation Display window
and its viewers.

Helpful Background Information

Motorola Solutions offers various courses designed to assist in learning about the system. For
information, go to http://www.motorolasolutions.com/training to view the current course offerings and
technology paths.

Related Information

See the following documents for associated information about the radio system.

Related Information Purpose
Standards and Guidelines for Commu- Provides standards and guidelines that should be followed
nication Sites when setting up a Motorola Solutions communications site.

Also known as R56 manual. This document may be pur-
chased by calling the North America Parts Organization at
800-422-4210 (or the international number: 302-444-9842).

System Overview and Documentation Provides an overview of the ASTRO® 25 new system fea-

Reference Guide tures, documentation set, technical illustrations, and sys-
tem-level disaster recovery that support the ASTRO® 25 ra-
dio communication system.

License Manager User Guide Provides information about the use of licenses to gain ac-
cess to features and functions in the ASTRO 25 system. It
describes the installation of the License Manager in the sys-
tem and explains how to use the web-based License Man-
ager user interface (Ul) to load, view, and manage licenses
in the system.
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Affiliation Display Description

This chapter provides a high-level description of Affiliation Display and the function it serves on your
system.

1.1
Affiliation Display Overview

Affiliation Display is an application that displays the association of a radio with a talkgroup and site, and
information about conventional channels, console sites, and consoles. It enables you to monitor how
radio users travel between different sites in a zone and how they communicate with other members of
their assigned talkgroup and those outside of their talkgroup. It monitors affiliation status for Analog
Conventional or ASTRO® 25 system Conventional channel availability.

E/ NOTICE: For ASTRO® 25 systems where a zone interfaces or coexists with equipment in an
ASTRO® 25 system conventional site, the term zone includes all infrastructure that is directly
related to the zone controller, which may include calls and signaling taking place on channels
shared with the ASTRO® 25 system. For example, a radio sending an emergency alarm on a
channel shared with an ASTRO® 25 system site displays the alarm independently on both the
ASTRO® 25 system and current infrastructures. You can decide how you want to monitor these
events and manage the possible duplication of the event on both infrastructures.

Affiliation Display Licensing

In the ASTRO® 25 system, you must purchase a license or licenses to get access to selected
applications, features, and services. Affiliation Display is a licensed applicationyou must purchase one
or more session licenses. The session license is used to manage a number of application client
sessions. For Affiliation Display, you can buy several licenses for a group of users. When a user starts
an Affiliation Display session, a license from a pool of your session licenses is used. For more
information, see the License Manager User Guide.

1.2

Purpose of Affiliation Display

Affiliation Display application lets you monitor the traffic for a selected zone.
You can use Affiliation Display to do the following:

* Dynamically monitor selected radios, sites, talkgroups, consoles, and conventional channels within
a zone.

* Monitor current affiliation/deaffiliation information for radios and consoles.
» Track how radios are roaming between sites, and how traffic moves within sites in a zone.
* Determine the sites and console sites where each talkgroup is currently operating.

» See how radio usage is distributed across sites and talkgroups, which can help determine if system
resources are deployed to maximize system performance.

» Display graphs of the site, console site, and talkgroup data.
The information is displayed in five ways:
* By console site ID/alias in the Console Site Conventional Viewer

» By conventional channel ID in the Conventional Channel Viewer
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* By radio ID/alias in the Radio Viewer
* By site ID/alias in the Site Viewer
» By talkgroup ID/alias in the Talkgroup Viewer

The Affiliation Display main window summarizes information for all five viewers. The information is
displayed in nearly real time and is constantly updated, as radios roam from one site to another or
change talkgroups. You can view a radio in more than one zone.

1.21
Console Site Conventional Viewer

Console Site Conventional Viewer enables you to monitor the current affiliation status for any console
sites available in the system. The window displays affiliation information for the console sites in the
zone, such as affiliated consoles, channels, and conventional talkgroups.

1.2.2
Conventional Channel Viewer

Conventional Channel Viewer allows you to monitor the current affiliation status for a conventional
channel available in the system. The window displays affiliation information for the console sites and
channels in the zone such as the console site |D/alias, console user ID, channel ID, timestamp of the
last change in affiliation, and the current affiliation status.

1.2.3
Radio Viewer

Radio Viewer allows you to monitor affiliations for one or more radios at one or more sites and locate
specified radios by ID. The window displays affiliation information for a custom list of radios. Each row
in the table shows the radio ID/alias and radio type, talkgroup ID/alias and number of talkgroups, site
ID/alias, timestamp of the last change in affiliation for the radio, and current affiliation status.

1.2.4
Site Viewer

Site Viewer allows you to monitor affiliations by site and view a list of talkgroups or radios at a site. The
window displays site type, ID/alias, and a number of talkgroups for that site, along with the number of
radios affiliated to each talkgroup. You can also view details on all the individual radio IDs/aliases
affiliated at the selected site. You can view site information for a single site or for all sites in a particular
zone.

1.2.5
Talkgroup Viewer

Talkgroup Viewer allows you to monitor affiliations by talkgroup. You can view information for all
available sites for a particular talkgroup or for all available radios associated with a particular talkgroup.
You can also view details on the individual site type, IDs/aliases, and the type of radios affiliated to that
talkgroup with the time of affiliation information and the current affiliation status.

Talkgroup affiliation information is included in the ATIA (Air Traffic Information Access) message. The
ATIA Log Viewer is a zone-level view of the talkgroup access mode, which can identify the talkgroup
access mode as either FDMA-only or TDMA-only at the zone-level.

Talkgroup affiliation information providing the talkgroup access mode for a given talkgroup is a zone-
level value and not a system-level value. Therefore, due to potentially dynamic nature of the talkgroup
access mode, when DDM-capable sites are employed in the system, it is possible for talkgroup
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affiliation information to indicate that the talkgroup access mode (FDMA-only, TDMA-only) for a given
talkgroup differs from zone to zone.

1.3
How Affiliation Display Works

The affiliation database resides on the Air Traffic Router server application (ATR), which receives radio
call traffic in the form of Air Traffic Information Access (ATIA) packets from the zone controller and
broadcasts these packets on the network as an ATIA stream.

The radio call traffic information in the ATIA packets contains talkgroup and site affiliation and

deaffiliation information for each user in a particular zone. The affiliation database collects this

information and provides updates to STM (System Traffic Monitor) applications such as Affiliation

Display.

I:;/ NOTICE: If the link between the Air Traffic Router and the zone controller is down, the
information displayed in the Affiliation Display is not adequate to the current affiliations in the
zone.

1.4

Affiliation Display Compared to ZoneWatch

Affiliation Display and ZoneWatch show different types of information. Affiliation Display is more
suitable to trace a state/location of a single subscriber, and is used to monitor location and affiliation
information organized by site, console site, radio, channel, or talkgroup. ZoneWatch is used to monitor
call traffic and allows you to organize displayed information using various criteria.
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Affiliation Display Operation

This chapter details tasks that you perform once the Affiliation Display is installed and operational on
your system.

21
Starting Affiliation Display
Use the Motorola Private Radio Network Management (PRNM) Suite Application Launcher to open the
Affiliation Display application.
Procedure:
1 Double-click the Motorola PRNM Suite icon on the desktop.
Figure 1: PRNM Suite Icon

The Motorola PRNM Application Launcher display window appears with a list of PRNM
application entities for each zone.

2 Double-click the Primary Zone Core or Backup Zone Core icon.
E/ NOTICE: For systems without the DSR feature, it is always Primary Zone Core.

A list of the available zones appears.

3 Click the icon for the zone that you want to monitor.

The Explorer Window content is updated with the proper applications for the selected zone.

4 Double-click the Affiliation Display icon.
The Affiliation Display main window appears.

2.2

Opening an Affiliation Display Viewer

Affiliation Display uses five different viewers to display specific affiliation information within a zone.
From the View menu in the Affiliation Display main window, select one of the following:

* Console Site Conventional Viewer to display affiliation information for selected console sites
» Conventional Channel Viewer to display information about conventional channels

» Radio Viewer to display affiliation information for selected radios

» Site Viewer to display affiliation information for selected sites in the zone

» Talkgroup Viewer to display affiliation information for selected talkgroups
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2.3
Console Site Conventional Viewer

The Console Site Conventional Viewer lets you monitor the current affiliation status for any console site
in the zone. See Affiliation Display Reference on page 39 for more information on the Console Site
Conventional Viewer.

2.3.1
Adding a Console Site to the Console Site Conventional Viewer

Procedure:

1 In the Console Site Conventional Viewer, type a valid Console Site ID or alias in the text box
on the toolbar.

2 Do one of the following:

¢ Press ENTER.

+ Click the Add Entry toolbar button +
* From the Entries menu, select Add Entry.

Information for the Console Site is added to the Selected Console Site Information list in the
Console Site Conventional Viewer.

2.3.2
Removing a Console Site from the Console Site Conventional

Viewer

Procedure:

1 In the Console Site Conventional Viewer, select a Console Site from the Selected Console
Site Information list.

2 Do one of the following:

+ Click the Remove Entry toolbar button -
* From the Entries menu, select Remove Entry.
* Right-click the entry and select Remove Entry.

The selected Console Site is removed from the Selected Console Site Information list in the
Console Site Conventional Viewer.

233
Viewing all Available Console Sites in the Console Site

Conventional Viewer

Procedure:

W
1 Click the View All Console Sites toolbar button T”I|-.

All the available console sites appear in the Selected Console Site Information list of the
Console Site Conventional Viewer.

2 To close the Console Site Conventional Viewer, click Close.
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234
Viewing a List of Conventional Channels for the Selected Console

Site

Procedure:

1 In the Console Site Conventional Viewer, select a Console Site from the Selected Console
Site Information list.

2 Do one of the following:

+ Click the View Conventional Channels for selected Entry toolbar button 2333,
* From the Entries menu, select View Conventional Channels.
* Right-click the entry and select View Conventional Channels.

A list of channels for a selected Console Site is displayed in the Channels at the Console Site
list.

2.3.5
Viewing a List of Conventional Talkgroups for the Selected Console

Site

Procedure:

1 In the Console Site Conventional Viewer, select a Console Site from the Selected Console
Site Information list.

2 Do one of the following:

b
B
« Click the View Conventional Talkgroups for selected Entry toolbar button I-":K .
* From the Entries menu, select View Conventional Talkgroups.
* Right-click the entry and select View Conventional Talkgroups.

A list of talkgroups for a selected Console Site is displayed in the Talkgroups at the Console Site
list.

2.3.6
Viewing a List of Consoles/Console Users for the Selected Console

Site

Procedure:

1 In the Console Site Conventional Viewer, select a Console Site from the Selected Console
Site Information list.

2 Do one of the following:

» Click the View Consoles for the selected Entry toolbar button EEE
* From the Entries menu, select View Consoles.
* Right-click the entry and select View Consoles.

A list of consoles for the selected Console Site is displayed in the Consoles at the Console
Window.
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II/; NOTICE: For ASTRO® 25 Conventional system, a list of console users is displayed in the
Consoles at the Console Site list.

2.3.7
Opening the Console Site Conventional Viewer Detail Window

Procedure:

1 In the Console Site Conventional Viewer, select a Console Site from the Selected Console
Site Information list.

2 Do one of the following:

* Click the Detail toolbar button .
¢ From the Entries menu, select Detail Window.
* Right-click the entry and select Detail Window.

The Detail Window for the selected console site appears with information specific to the console
site. The title bar displays the name of the console site.

2.4
Conventional Channel Viewer

Conventional Channel Viewer allows you to view the current affiliation status for conventional
channels. The window displays the number of console sites having consoles affiliated to the channel.
See Affiliation Display Reference on page 39 for more information on the Conventional Channel
Viewer.

241
Adding a Channel to the Conventional Channel Viewer

Procedure:

1 In the Conventional Channel Viewer, type a valid Channel Number, a Conventional Site ID, or
alias and Zone ID in the text boxes on the toolbar.

2 Do one of the following:

* Press ENTER.

« Click the Add Entry toolbar button LI'I' :
* From the Entries menu, select Add Entry.

Information for the Conventional Channels is added to the Selected Conventional Channel
Information list in the Conventional Channel Viewer.

2.4.2
Removing a Channel from the Conventional Channel Viewer

Procedure:

1 In the Conventional Channel Viewer, select a channel from the Selected Conventional
Channel Information list.

2 Do one of the following:
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» Click the Remove Entry toolbar button -
* From the Entries menu, select Remove Entry.
* Right-click the entry and select Remove Entry.

The selected channel is removed from the Selected Conventional Channel Information list in
the Conventional Channel Viewer.

243
Viewing a List of Console Sites for the Selected Channel

Procedure:

1 In the Conventional Channel Viewer, select a Channel from the Selected Conventional
Channel Information list.

2 Do one of the following:

"0
+ Click the View Console Sites for the selected Entry toolbar button “* .

*  From the Entries menu, select View Console Sites.
* Right-click the entry and select View Console Sites.

A list of console sites for the selected Channel is displayed in the Console Sites at Channel in
the Conventional Channel Viewer.

2.4.4
Viewing a List of Console Users for the Selected Channel

Procedure:

1 In the Conventional Channel Viewer, select the channel from the Selected Conventional
Channel Information list.

2 Do one of the following:

+ Click the View Consoles toolbar button for the selected entry EEE
*  From the Entries menu, select View Consoles.
* Right-click the entry and select View Consoles.

A list of console users who are configured on the console computer and on the selected channel
is displayed in the Consoles at the Channel list.

E/ NOTICE: For Analog Conventional, a list of consoles for the selected channel is
displayed in the Consoles at the Channel list.

2.4.5
Opening the Conventional Channel Viewer Detail Window

Procedure:

1 In the Conventional Channel Viewer, select a channel from the Selected Conventional
Channel Information list.

2 Do one of the following:
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* Click the Detail toolbar button .
*  From the Entries menu, select Detail Window.
* Right-click the entry and select Detail Window.

The Detail Window for the selected channel appears with information specific to the channel.
The title bar displays the number of the channel.

2.5
Radio Viewer

The Radio Viewer window lets you monitor site affiliation and talkgroup affiliation for the selected
radios. It allows you to monitor selected sites and console sites. The following three radio types can be
monitored:

* CON - Console (trunking resources)
* HPD - High Performance Data Radio
* IVD - Integrated Voice and Data Radio (trunking resources)

E/ NOTICE: UNK status displays when the radio type cannot be determined.

2.51
Adding a Radio to the Radio Viewer

When and where to use: To view affiliation information for a specific radio, add the radio to the Radio
Viewer using either the ID or the alias. You also must choose the system from the combo box.

I:;/ NOTICE: To display all the radios with the same ID or the alias use All Systems option in a
combo box.
You can view the valid radio IDs and aliases in your system by browsing through the radio user
records in the Provisioning Manager.
Procedure:

1 In the Radio Viewer, type a valid radio ID or alias in the text box and select the system from the
combo box on the toolbar.

2 Do one of the following:

e Press ENTER.

» Click the Add Entry toolbar button +
* From the Entries menu, select Add Entry.

Information for the radio ID is added to the Selected Radio Information list in the Radio
Viewer.

2.5.2
Removing a Radio from the Radio Viewer

Procedure:
1 In the Radio Viewer, select a radio from the Selected Radio Information list.

2 Do one of the following:
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» Click the Remove Entry toolbar button -

* From the Entries menu, select Remove Entry.

* Right-click the entry and select Remove Entry.

The selected radio is removed from the Selected Radio Information list in the Radio Viewer.

2.5.3

Locating a Radio in the Radio Viewer

When and where to use: You can use the Radio Viewer to show location information for an individual
radio.

Procedure:

1 In the Radio Viewer, type a valid radio ID or alias in the text box and select the system from the
combo box on the toolbar.

2 Do one of the following:

« Click the Locate Radio toolbar button @
¢  From the Entries menu, select Locate Radio.

The Radio Locator window appears with the affiliated site and talkgroup information for the
selected radio.

3 To close the Radio Locator window, click Close.

2.5.4
Viewing a List of Talkgroups for the Selected Radio in the Radio

Viewer

Use this procedure to see the number of talkgroups to which the console is affiliated. It is active only
for the consoles currently affiliated to more than one talkgroup.

Procedure:
1 In the Radio Viewer, type a valid radio ID or alias in the text box on the toolbar.

2 Do one of the following:

» Click the View a list of Talkgroups toolbar button h":\....

+ From the Entries menu, select View Talkgroups.

* Right-click the entry and select View Talkgroups.

The information about talkgroups for the selected entry is displayed.

3 To close the Radio Viewer Talkgroup list, click Close.

2.5.5
Opening the Radio Detail Window

The Detail Window for a radio displays information about talkgroups and information about the site in
which the radio is affiliated.
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Procedure:
1 In the Radio Viewer, select a radio from the Selected Radio Information list.

2 Do one of the following:

+ Click the Detail toolbar button .

* From the Entries menu, select Detail Window.

* Right-click the entry and select Detail Window.

The Detail Window for the selected site appears with information specific to the radio.

2.6
Site Viewer

The Site Viewer displays information for radios registered and talkgroups affiliated with one or more
sites in the zone. Using this window allows you to obtain a picture of how radio activity is concentrated
by site. It can be useful to determine, weather system resources are deployed to maximize system
performance. The following three site types can be monitored:

*+ CON - Console

* HPD - High Performance Data

* IVD - Integrated Voice and Data

E/ NOTICE: UNK status displays when site type cannot be determined.

2.6.1
Adding a Site to the Site Viewer

Use this procedure to view radio and talkgroup affiliation information for a specific site, add the site ID
or site alias to the Site Viewer.

E/ NOTICE: You can view the valid site IDs and aliases in a zone by browsing through the site
records in the Provisioning Manager.

Procedure:
1 In the Site Viewer, type a valid site ID or site alias in the text box on the toolbar.
2 Do one of the following:

e Press ENTER.

+ Click the Add Entry toolbar button +
* From the Entries menu, select Add Entry.

Information for the site appears in the Selected Site Information list in the Site Viewer.

2.6.2
Adding All Available Sites to the Site Viewer

Procedure:
In the Site Viewer, do one of the following:

R
i
+ Click the Add Sites toolbar button “I"+.
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*  From the Entries menu, select All Sites.

Information for all available sites appears in the Selected Site Information list in the Site
Viewer.

2.6.3
Removing a Site from the Site Viewer

Procedure:
1 In the Site Viewer, select a site from the Selected Site Information list.

2 Do one of the following:

+ Click the Remove Entry toolbar button -
* From the Entries menu, select Remove Entry.

* Right-click an entry and select Remove Entry.

Information for the selected site is removed from the Selected Site Information list in the Site
Viewer.

2.6.4
Viewing a List of Talkgroups for the Selected Site

Procedure:
1 In the Site Viewer, select a site from the Selected Site Information list.

2 Do one of the following:

b
b
+ Click the View Talkgroups toolbar button h":\ .
« From the Entries menu, select View Talkgroups.
+ Right-click the entry and select View Talkgroups.

Information for all available talkgroups appears in the Talkgroups at the Site detail list in the Site
Viewer.

2.6.5
Viewing a List of Radios for the Selected Site

Procedure:
1 In the Site Viewer, select a site from the Selected Site Information list.

2 Do one of the following:

» Click the View Radios toolbar button EEE

* From the Entries menu, select View Radios.

* Right-click the entry and select View Radios.

Information for all available radios appears in the Radios at the Site detail list in the Site Viewer.
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2.6.6
Opening the Site Detail Window

The Detail Window displays information for all the talkgroups and radios affiliated to a particular site.

Procedure:
1 In the Site Viewer, select a site from the Selected Site Information list.

2 Do one of the following:

» Click the Detail toolbar button .
*  From the Entries menu, select Detail Window.
* Right-click the entry and select Detail Window.

The Detail Window for the selected site appears with information specific to the site. The title bar
displays the name of the site.

2.6.7
Graphing Affiliations for a Site

Procedure:
1 In the Site Viewer, select a site from the Selected Site Information list.
2 From the Entries menu, select View Talkgroups.
A list of Talkgroups appears in the Talkgroups at the Site detail list. Graph Sites button
becomes active.
3 Do one of the following:

Wil
+ Click the Graph Sites toolbar button Tx'éﬂ.

* From the Entries menu, select Graph Sites.
A bar graph appears showing the number of talkgroups and radios at the selected site.
E/ NOTICE: At least one site must be listed in Site Viewer to be able to graph talkgroups.

2.6.8
Graphing Talkgroup Affiliations for a Site

Procedure:
1 In the Site Viewer, select a site from the Selected Site Information list.
2 From the Site Viewer Entries menu, select View Talkgroups.

Talkgroups for a selected site appear in the Talkgroups at the Site detail list in the Site Viewer
window.

3 Do one of the following:

[
i
+ Click the Graph Talkgroups toolbar button hh\dj].
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* From the Entries menu, select Graph Talkgroups.

A bar graph appears, showing the number of radios affiliated with one or more talkgroups at a
specific site.

2.7

Affiliation Display Talkgroup Viewer

The Talkgroup Viewer displays information on radios and sites affiliated with one or more talkgroups in
the zone. See Talkgroup Viewer on page 22 for details.

2.7.1
Adding a Talkgroup to the Talkgroup Viewer

When and where to use: You can view affiliation information for a specific talkgroup, including which
radios are affiliated to the talkgroup and the sites where the users are located. To view this information,
add the talkgroup to the Talkgroup Viewer using either the ID or the alias and system.

E/ NOTICE: You can view the valid talkgroup types, IDs, and aliases in your system by browsing
through the talkgroup and multigroup records in the Provisioning Manager.

Procedure:

1 In the Talkgroup Viewer, type a valid talkgroup ID or alias in the text box and select the system
from the combo box on the toolbar.

2 Do one of the following:

e Press ENTER.

+ Click the Add Entry toolbar button +
* From the Entries menu, select Add Entry.

Information for the talkgroup appears in the Selected Talkgroup Information list in the
Talkgroup Viewer.

2.7.2
Removing a Talkgroup from the Talkgroup Viewer

Procedure:
1 In the Talkgroup Viewer, select a talkgroup from the Selected Talkgroup Information list.

2 Do one of the following:

» Click the Remove Entry toolbar button -
* From the Entries menu, select Remove Entry.
* Right-click an entry and select Remove Entry.

Information for the selected talkgroup is removed from the Selected Talkgroup Information list
in the Talkgroup Viewer.

Send Feedback 35


http://docsurvey.motorolasolutions.com

MNO004281A01-A
Chapter 2: Affiliation Display Operation

2.7.3
Viewing a List of Sites for the Selected Talkgroup

Procedure:
1 Inthe Talkgroup Viewer, select a talkgroup from the Selected Talkgroup Information list.
2 Do one of the following:

b ”nxTn
+ Click the View Sites toolbar button ‘" .

* From the Entries menu, select View Sites.
* Right-click the entry and select View Sites.

Information for all the available sites appears in the Sites at the Talkgroup detail list in the
Talkgroup Viewer.

2.7.4
Viewing a List of Radios for the Selected Talkgroup

Procedure:
1 Inthe Talkgroup Viewer, select a talkgroup from the Selected Talkgroup Information list.

2 Do one of the following:

» Click the View Radios toolbar button EEE
¢ From the Entries menu, select View Radios.
* Right-click the entry and select View Radios.

Information for all the available radios appears in the Radios at the Talkgroup detail list in the
Talkgroup Viewer.

2.7.5
Opening the Talkgroup Detail Window

The Detail Window displays information for all sites and radios affiliated to a particular talkgroup.

Procedure:
1 In the Talkgroup Viewer, select a talkgroup from the Selected Talkgroup Information list.

2 Do one of the following:

* Click the Detail toolbar button .
¢ From the Entries menu, select Detail Window.
* Right-click the entry and select Detail Window.

The Detail Window for the selected talkgroup appears with information specific to the talkgroup.
The title bar displays the name of the talkgroup.
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2.7.6
Graphing Talkgroup Affiliations in the Talkgroup Viewer

Procedure:
1 Inthe Talkgroup Viewer, select a talkgroup from the Selected Talkgroup Information list.

2 Do one of the following:

I
il

» Click the Graph Talkgroups toolbar button h'\d:[l.

* From the Entries menu, select Graph Talkgroups.

A bar graph appears showing the number of sites and radios in the zone that are affiliated to
each selected talkgroup.

2.7.7
Graphing Site Affiliations for a Talkgroup in the Talkgroup Viewer

Procedure:
1 In the Talkgroup Viewer, select a talkgroup from the Selected Talkgroup Information list.
2 From the Talkgroup Viewer Entries menu, select View Sites.
3 Do one of the following:

R
+ Click the Graph Sites toolbar button T”nTj].

* From the Entries menu, select Graph Sites.

A bar graph appears showing the number of radios at each site within the zone affiliated to a
specific talkgroup.

2.8
Sorting Entries on a Viewer

Procedure:
1 Select a column on the viewer.
2 Do the following:
+ To sort entries in the ascending order, click the column.
+ To sort entries in the descending order, click the column again.

The entries in the column are sorted in the order you indicated.

29
Closing a Viewer

In the Viewer, select Close from the File menu.

E/ NOTICE: Information about talkgroups added to the viewer is retained even after the Talkgroup
Viewer is closed, as long as the Affiliation Display main application is open. The added
talkgroups are listed in the Selected Talkgroups Information list when the window is reopened.

Send Feedback 37


http://docsurvey.motorolasolutions.com

MNO004281A01-A
Chapter 2: Affiliation Display Operation

210

Exiting Affiliation Display

To exit the Affiliation Display, do one of the following:

» Select Exit from the File menu on the main window.
* Click Close on the main window.

» Select Exit from the File menu of any viewer window.

E/ NOTICE: The information you have added in the viewers is not retained when you exit the
Affiliation Display main application.
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Chapter 3

Affiliation Display Reference

This chapter contains supplemental reference information relating to the Affiliation Display.

3.1

Affiliation Display Main Window

The Affiliation Display main window has three summary forms which display affiliation information by
talkgroup, site, and individual radio and two summary forms which display conventional affiliation
confirmation by Conventional Channel or Console Site. The information in these forms reflects the
selections made in the viewer windows. The summary forms are also updated when there are changes

to the affiliation or the registration status of a radio or a talkgroup.

Figure 2: Affiliation Display Main Window
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File ¥iew Window Help
1~ Affilistion Viewer Summaties
rSelected Talkgroup Information Selected Site Information — 1 5elected Console Site Information
: T Talkgroup Alias Tgld Sikes | Radios ;Site Tooe Site Alias # 5it...| Tgs | Affs |Rad.. | t Cons Site ... | Cons Site ID | Chans | Cons | Conw ...
|[TG-2 80001282 2 2 HPD  |site-1 1 1 1 1 | ||cs-1001 1001 a 1] 1]
| TG-1 80001281 1 2 HPD  |site-2 2 1] a a | [{cs-1002 1002 2 1 2
| [CONYTG-1 80004281 1 1 HPD  |site-3 3 1] a a
HPD  |site-4 4 1] a a 3
HPD  |site-5 L 1] a a 3
[COM es-1001 1001 |0 a a
|COM es-1002 1002 |4 L 2
|COM |es-1003 1003 |0 a a =
| |COM  es-1004 1004 |0 a a ™|
:-.Selected Radio Information - | [ Felected Conventional Channel iﬁformation
f; ...| Radio Alias | Radi... | Tgs| Talkgrou...| Tgld | Site Alias | Sit...| Date | Current ... fConv Chan...| # Conv Si...| Conv Site Alias | Conw Ch... | ConsSites | Cons |Chan ...
;.CON Consolet (902 |4 cs-1002 1002 (Tue ... | Affiliated ;_11 2002 cys-2002 3 1 1
| WD |Radiol |1 1 |TG-2 8000... |site-1 1 Tue ... |Afiiliated || 12 2002 cys-2002 3 1 1
v ATR
The title of the Affiliation Display main window displays additional data:
Zone ID
The current zone ID that the user is logged on.
Zone Alias
The current zone alias that the user is logged on.
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Zone Core

The Primary Core or Backup Core. If Affiliation Display is connected to Primary Zone Core, it is the
Primary Core. If Affiliation Display is connected to Backup Zone Core, it is Backup Core.

Table 1: Main Window Summary Forms

The following table shows the different Summary Forms and examples of information provided by the

Affiliation Display.

Summary Form

Types of Information

Selected Talkgroup Informa-
tion

The number of sites registered with each selected talkgroup.

The number of radio units affiliated with each selected talk-
group.

Selected Site Information

The number of talkgroups registered for each selected site.
The number of radio units registered for each selected site.
Site type information.

The total number of affiliations for each selected site.

Selected Radio Information

Talkgroup affiliation for each selected radio unit.
Current Status of the radio for the site.
Radio type information.

Date- displays date of the last affiliation or deaffiliation by the
radio.

Radio Alias
Radio Id

Selected Console Site Infor-
mation

The number of consoles for each selected console site (analog
channels) or the number of console users for each selected
console site (digital channels).

The number of channels for each selected console site.

The number of conventional talkgroups to which at least one
console from the console site is affiliated.

Selected Conventional
Channel Information

Conventional Site ID and alias for the selected conventional
channel.

ZonelD of the conventional channel.

Number of consoles affiliated to conventional channel.
Number of console sites.

ID of conventional channel group.
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Affiliation Display Main Window Menu Bar

The following table describes the Affiliation Display Main Window menu options:

Table 2: Main Window Menu Bar

Menu Option Drop-down Option Description

File Exit Closes the application.

View Console Site Conventional View-  Opens the Console Site Conventional

er Viewer window.

Conventional Channel Viewer Opens the Conventional Channel Site
Viewer window.

Radio Viewer Opens the Radio Viewer window.

Site Viewer Opens the Site Viewer window.

Talkgroup Viewer Opens the Talkgroup Viewer window.

Window Affiliation Display While the Affiliation Display main window
is open, it gives access to all the opened
viewer windows. The user can switch
from one viewer window to another.

Radio Viewer If the Radio Viewer is open, you can use
this option to display it.

Site Viewer If the Site Viewer is open, you can use
this option to display it.

Console Site Conventional View-  If the Console Site Conventional Viewer

er is open, you can use this option to dis-
play it.

Talkgroup Viewer If the Talkgroup Viewer is open, you can
use this option to display it.

Conventional Channel Viewer If the Conventional Channel Viewer is
open, you can use this option to display
it.

Help Help Topics Provides online help on the various tabs,
menus, and actions of the Affiliation Dis-
play. You can also use CTrL +T to dis-
play it.

About Affiliation Display Opens the About Affiliation Display win-
dow to provide information about the ap-
plication.

3.3

Status Bar and Progress Bar

The status bar appears in all Affiliation Display windows (apart from the Radio Locator window). It
displays the status of the connection with the Air Traffic Router (ATR). See the following:

v

Server connected.
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b 4

Server disconnected.

The progress bar appears during data download from the Affiliation Server (for example, for the list of
consoles, talkgroups, or radios).

34
Console Site Conventional Viewer

The Console Site Conventional Viewer window displays the current conventional affiliation status of
console sites. For Analog Conventional, the window displays the number of consoles, and for ASTRO®
25 Conventional system, it displays the number of console users.

The window also displays the following information:

¢ current number of conventional channels to which at least one console in the console site is
affiliated

* number of currently affiliated consoles/console users in the console site
* number of conventional talkgroups to which at least one console from the console site is affiliated

E/ NOTICE: The number of consoles for each selected console site is provided for analog channel
resources and the number of console users is provided for each selected console site for digital
channels.

Figure 3: Console Site Conventional Viewer Display Window

::'ﬁ Console Site Conventional Wiewer - Zone3 E”E
File ¥iew Entries Window Help
| + 1Bl = e o W
| -Selected Cansale Site Informatian Channels at Console Site 1002 -
+ Cons Site Alias Cons Site ID Chans Cons Conv Tgs Conv CHan Mum | Conv Site ID Cony Site Alias Conv Chan ... | Cons |Conv... | ChanG...
cs-1001 1001 a a a 11 2002 cys-2002 3 1 1
cs-1002 1002 2 1 2 12 2002 cys-2002 3 1 1
Consoles at Consﬁle Site iDDZ Conv, '.I.'alkgroups ak Console Site lﬁDZ-
[ Cons Alias l Conv Cha... |.Chan Gro... l Cony Site Alias IConv Site ID |.C0nv | Chan Num | Conv Tgs | Date | Group Alias Group ID Cons
Consalel | | | | | |2 |2 [Tue Mar 11 14:40:19 . || || [COMNVTG-1 20004281 |1
CONYTG-3 80004283 [1
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Related Links

Console Site Conventional Viewer Window on page 43
Console Site Conventional Viewer Fields: Selected Console Site Information on page 43
Console Site Conventional Viewer Fields: Consoles at Console Sites on page 45

Console Site Conventional Viewer Fields: Channels and Conventional Talkgroups at Console Sites on
page 44
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Console Site Conventional Viewer Menu Bar on page 45

3.4.1
Console Site Conventional Viewer Window

Text Box
Used for entering the console site ID or alias.

+ Add Entry
Adds the console site ID or alias entered in the text box.

L ey
"+ View all Console Sites
Adds all available console sites.

Remove Entry
Removes a selected console site ID or alias from the viewer window.

)13 View List of Conventional Channels
Displays details about all channels at the selected console site.

EEE View List of Consoles
Displays details about all available consoles (analog)/console users (digital) at the selected console
site.

b
Bl
I-":l\ View Conventional Talkgroups
Displays details about all conventional talkgroups at the selected console site.

Detail Window

Opens the Detail Window for the selected entry.

3.4.2
Console Site Conventional Viewer Fields: Selected Console Site
Information

Table 3: Console Site Conventional Viewer Fields: Selected Console Site Information

Field Description
Cons Site Alias Read-only field — displays a unique name that refers to a specific console
site.

E/ NOTICE: For foreign consoles 2 aliases separated with a colon (*")
are displayed: console alias and alias of the foreign system.

Cons Site ID Read-only field — displays a unique number that refers to a specific console
site.

IZ/ NOTICE: For foreign consoles ID consists of console ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Chans Read-only field — displays the number of affiliation channels for the selected
entry.

Table continued...
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Field Description

Cons Read-only field — displays the total number of consoles/console users affili-
ated to conventional channels at the console site.

Conv Tgs Read-only field — displays the number of conventional talkgroups, with at
least one console affiliation, for the selected entry.

3.4.3
Console Site Conventional Viewer Fields: Channels and

Conventional Talkgroups at Console Sites

Channels at Console Site

Table 4: Console Site Conventional Viewer Fields: Channels at Console Site

Field Description

Conv Chan Num Read-only field — displays the channel ID of the channel at the selected con-
ventional site.

Conv Site ID Read-only field — displays a unique number that refers to a specific conven-
tional site.

Conv Site Alias Read-only field — displays a unique name that refers to a specific conven-
tional site.

Conv Chan Zone Read-only field — displays the zone ID of channel.

Id

Cons Read-only field — displays the total number of consoles/console users which
are currently affiliated to the selected conventional channel.

Conv Tgs Read-only field — displays the number of conventional talkgroups, with at
least one console affiliation, for the selected entry.

Chan Group ID Read-only field — displays the Channel Group ID.

Conventional Talkgroups at Console Sites

Table 5: Console Site Conventional Viewer Fields: Conventional Talkgroups at Console Sites

Field Description

Group Alias Displays a unique name that refers to a specific talkgroup.

Group ID Displays a unique number that refers to a specific talkgroup.

Cons Displays the number of consoles or console users that are currently affiliated

to a selected conventional talkgroup.
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Console Site Conventional Viewer Fields: Consoles at Console Sites

Consoles at Console Site

Table 6: Console Site Conventional Viewer Fields: Consoles at Console Site

Field

Description

Cons Alias

Read-only field — displays a unique name that refers to a specific console.

E/ NOTICE: For Analog Conventional, it displays the console alias but
for ASTRO® 25 Conventional it displays the console user alias.

For foreign consoles 2 aliases separated with a colon (“:”) are dis-
played: console alias and alias of the foreign system.

Conv Chan Num

Read-only field — displays the conventional channel ID.

Chan Group ID

Read-only field — displays the Channel Group ID.

Conv Site Alias

Read-only field — displays a unique name that refers to a specific conven-
tional site.

Conv Site ID

Read-only field — displays a unique number that refers to a specific conven-
tional site.

Conv Chan Zone
ID

Read-only field — displays the zone ID of channel

Chan Num Read-only field — displays the number of channels a console is affiliated to.

Conv Tgs Read-only field — displays the number of conventional talkgroups, with at
least one console affiliation, for the selected entry.

Date Read-only field — displays the date of the last affiliation or deaffiliation of the
console site to this conventional channel.

3.4.5

Console Site Conventional Viewer Menu Bar

Table 7: Console Site Conventional Viewer Menu Bar

Menu Option Drop-down Option Description
File Close Closes the currently selected window.
Exit Closes the application.
View Console Site Convention- Opens the Console Site Conventional Viewer.
al Viewer
Conventional Channel Opens the Conventional Channel Viewer.
Viewer
Radio Viewer Opens the Radio Viewer.
Site Viewer Opens the Site Viewer.
Talkgroup Viewer Opens the Talkgroup Viewer.
Entries Add Entry Adds a new console site to the Console Site

Conventional Viewer.
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Menu Option Drop-down Option

Description

All Sites

Adds all console sites affiliated in the system.

Remove Entry

Removes a selected console site from the Con-
sole Site Conventional Viewer window.

View Conventional Chan-
nels

View a list of conventional channels for the se-
lected console site.

View Consoles

View a list of consoles for the selected console
site.

View Conventional Talk-

View a list of conventional talkgroups for the

groups selected console site, to which at least one
console from the console site is affiliated.
Detail Window Opens a Detail Window.
Window Affiliation Display Displays the Affiliation Display window.
Site Viewer Displays the Site Viewer, if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Console Site Convention-
al Viewer

Displays the Console Site Conventional Viewer,
if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Conventional Channel
Viewer

Displays the Conventional Channel Viewer, if it
is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Radio Viewer

Displays the Radio Viewer, if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Talkgroup Viewer

Displays the Talkgroup Viewer, if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Help Help Topics

Opens the online help.

About Affiliation Display

Opens a About Affiliation Display window that
provides information about the application.
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Console Site Conventional Viewer Pop-up Menu

The following pop-up menu opens when you right-click any entry inside the Console Site Conventional

Viewer:

Table 8: Console Site Conventional Viewer Pop-up Menu
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Menu Op-

tion Description

Remove En-  Removes a selected entry from the Console Site Conventional Viewer window.

try

View Con- Displays information for all channels at the selected console site.

ventional

Channels

View Con- View a list of conventional talkgroups for the selected console site, to which at least
ventional one console from the console site is affiliated.

Talkgroups

View Con- Displays information for all available consoles/console users at the selected con-
soles sole site.

Detail Win- Opens the Detail Window, showing the console and channel information for the se-
dow lected console site.

3.4.7

Console Site Conventional Viewer Detail Window

Figure 4: Console Site Conventional Viewer Detail Window
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Tables in the following sections describe different fields of the Console Site Conventional Viewer Detail

Window:

» Console Site Conventional Viewer Detail Window: Selected Console Site Information on page 48

* Console Site Conventional Viewer Detail Window: Channels at Console Site on page 48

» Console Site Conventional Viewer Detail Window: Consoles and Conventional Talkgroups at
Console Sites on page 49

3.4.71

Console Site Conventional Viewer Detail Window: Selected Console Site

Information

Table 9: Console Site Conventional Viewer Detail Window: Selected Console Site Information

Field

Description

Cons Site Alias

Read-only field — displays a unique name that refers to a specific console
site.

E/ NOTICE: For foreign consoles 2 aliases separated with a colon (")
are displayed: console alias and alias of the foreign system.

Cons Site ID Read-only field — displays a unique number that refers to a specific console
site.
IZ/ NOTICE: For foreign consoles ID consists of console ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).
Chans Read-only field — displays the number of all channels for the selected entry.
Cons Read-only field — displays the total number of consoles/console users affili-
ated to conventional channels at the console site.
Conv Tgs Read-only field — displays the number of conventional talkgroups, with at
least one console affiliation, for the selected entry.
3.4.7.2

Console Site Conventional Viewer Detail Window: Channels at Console

Site

Table 10: Console Site Conventional Viewer Detail Window: Channels at Console Site

Field

Description

Conv Chan Num

Read-only field — displays the channel ID of the channel at the selected con-
ventional site.

Conv Site ID

Read-only field — displays a unique number that refers to a specific conven-
tional site.

Conv Site Alias

Read-only field — displays a unique name that refers to a specific conven-
tional site.

Conv Chan Zone
Id

Read-only field — displays the zone ID of the channel.
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Field Description

Cons Read-only field — displays the total number of consoles/console users which
are currently affiliated to the selected conventional channel.

Conv Tgs Read-only field — displays the number of conventional talkgroups, with at

least one console affiliation, for the selected entry.

Chan Group ID

Read-only field — displays the Channel Group ID.

3.4.7.3

Console Site Conventional Viewer Detail Window: Consoles and
Conventional Talkgroups at Console Sites

Consoles at Console Site

Table 11: Console Site Conventional Viewer Detail Window: Consoles at Console Site

Field

Description

Cons Alias

Read-only field — displays a unique name that refers to a specific console.

E/ NOTICE: For Analog Conventional, it displays the console alias but
for ASTRO® 25 Conventional it displays the console user alias.

For foreign consoles 2 aliases separated with a colon (“:”) are dis-
played: console alias and alias of the foreign system.

Conv Chan Num

Read-only field — displays the conventional channel ID.

Chan Group ID

Read-only field — displays the Channel Group ID.

Conv Site Alias

Read-only field — displays a unique name that refers to a specific conven-
tional site.

Conv Site ID

Read-only field — displays a unique number that refers to a specific conven-
tional site.

Conv Chan Zone
ID

Read-only field — displays the zone ID of channel

Chan Num Read-only field — displays the number of channels a console is affiliated to.

Conv Tgs Read-only field — displays the number of conventional talkgroups, with at
least one console affiliation, for the selected entry.

Date Read-only field — displays the date of the last affiliation or deaffiliation of the

console site to this conventional channel.

Conventional Talkgroups at Console Sites

Table 12: Console Site Conventional Viewer Detail Window: Conventional Talkgroups at Console Sites

Field Description

Group Alias Displays a unique name that refers to a specific talkgroup.

Group ID Displays a unique number that refers to a specific talkgroup.

Cons Displays the number of consoles or console users in the selected console

site, that are currently affiliated to a selected conventional talkgroup.
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3.5
Conventional Channel Viewer

The Conventional Channel Viewer allows you to view the current affiliation status for channels. The
window displays the information about channels. Each row in the table shows the channel ID, console
site ID/alias, channel zone ID, the number of consoles/console users, the number of console sites and
the timestamp of the last change in the affiliation status.

Figure 5: Conventional Channel Viewer Display Window
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Tables in the following sections describe the different fields of the Conventional Channel Viewer
Display window:

* Conventional Channel Viewer Window on page 50

» Conventional Channel Viewer Fields: Selected Conventional Channel Information on page 51
« Conventional Channel Viewer Fields: Console Sites at Channel on page 51

* Conventional Channel Viewer Fields: Consoles at Channel on page 52

» Conventional Channel Viewer Menu Bar on page 52

3.5.1
Conventional Channel Viewer Window
Text Box — Channel Number

Used for entering the channel ID.

Text Box — Conv Site ID/Alias
Used for entering the conventional site ID or alias.

Text Box— Zone ID
Used for entering channel zone ID.

+ Add Entry
Adds the channel entered in the text box.

Remove Entry
Removes a selected channel from the viewer window.

Wil
" View a List of Console Sites
Displays information about console sites for the selected entry.
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EEE View a List of Consoles
Displays information about all available consoles/console users for the selected entry.

Detail Window

Opens the Detail Window for the selected entry.

3.5.2

Conventional Channel Viewer Fields: Selected Conventional
Channel Information

Table 13: Conventional Channel Viewer Fields: Selected Conventional Channel Information

Field

Description

Conv Chan Num

Read-only field — displays the channel ID.

Conv Site ID

Read-only field — displays a unique number that refers to a specific conven-
tional site.

Conv Site Alias

Read-only field — displays a unique name that refers to a specific site.

Conv Chan Zone
ID

Read-only field — displays the zone ID of channel

Cons Sites

Read-only field — displays the total number of console sites.

Cons

Read-only field — displays the total number of consoles/console users.

Chan Group ID

Read-only field — displays the identification number of the channel group.

3.5.3

Conventional Channel Viewer Fields: Console Sites at Channel

Table 14: Conventional Channel Viewer Fields: Console Sites at Channel

Field

Description

Cons Site Alias

Read-only field — displays a unique name that refers to a specific console
site.

IZ/ NOTICE: For foreign consoles 2 aliases separated with a colon (*:
are displayed: console alias and alias of the foreign system.

Cons Site ID Read-only field — displays a unique number that refers to a specific console
site.
E/ NOTICE: For foreign consoles ID consists of console ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).
Cons Read-only field — displays the total number of consoles/console users which

are currently affiliated to the selected conventional channel.
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3.54

Conventional Channel Viewer Fields: Consoles at Channel

Table 15: Conventional Channel Viewer Fields: Consoles at Channel

Field

Description

Cons Alias

Read-only field — displays a unique name that refers to a specific console.

E/ NOTICE: For Analog Conventional, it displays a console alias but
for ASTRO® 25 Conventional it displays the console user alias. For

foreign consoles 2 aliases separated with a colon (“:”) are dis-
played: console alias and alias of the foreign system.

Chan Num

Read-only field — displays the number of channels a console is affiliated to.

Cons Site Alias

Read-only field — displays a unique name that refers to a specific console
site.

Cons Site ID Read-only field — displays a unique number that refers to a specific console
site.

Date Read-only field — displays the date of the last affiliation or deaffiliation of the
console to this conventional channel.

3.5.5

Conventional Channel Viewer Menu Bar

Table 16: Conventional Channel Viewer Menu Bar

Menu Option Drop-down Option Description
File Close Closes the currently selected window.
Exit Closes the application.
View Console Site Convention- Opens the Console Site Conventional Viewer.
al Viewer
Conventional Channel Opens the Conventional Channel Viewer.
Viewer
Radio Viewer Opens the Radio Viewer.
Site Viewer Opens the Site Viewer
Talkgroup Viewer Opens the Talkgroup Viewer
Entries Add Entry Adds a new console site to the Conventional
Channel Viewer.
Remove Entry Removes a selected console site from the Con-
ventional Channel Viewer window.
View Console Sites View a list of console sites.
View Consoles View a list of consoles for the selected console
site.
Detail Window Opens a Detail Window.
Window Affiliation Display Displays the Affiliation Display window.
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Menu Option

Drop-down Option Description

Site Viewer Displays the Site Viewer, if it is open.
To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Console Site Convention- Displays the Console Site Conventional Viewer,
al Viewer if it is open.
To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Conventional Channel Displays the Conventional Channel Viewer, if it
Viewer is open.
To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Radio Viewer Displays the Radio Viewer, if it is open.
To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Talkgroup Viewer Displays the Talkgroup Viewer, if it is open.
To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Help

Help Topics Opens the online help.

About Affiliation Display Opens a About Affiliation Display window that
provides information about the application.

3.5.6

Conventional Channel Viewer Pop-up Menu

The following pop-up menu opens when you right-click any entry inside the Conventional Channel

Viewer:

Table 17: Conventional Channel Viewer Pop-up Menu

Menu Option

Description

Remove Entry

Removes a selected entry from the Conventional Channel Viewer window.

View Console
Sites

Displays information for all available console sites.

View Consoles

Displays information for all available consoles/console users.

Detail Window

Opens the Detail Window, showing the radios and talkgroups affiliated to a
selected site.
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3.5.7

Conventional Channel Viewer Detail Window

Figure 6: Conventional Channel Viewer Detail Window
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Tables in the following sections describe the different areas of the Conventional Channel Viewer Detail

Window:

» Conventional Channel Viewer Detail Window: Selected Conventional Channel Information on page

54

» Conventional Channel Viewer Detail Window: Console Sites at Channel on page 55

» Conventional Channel Viewer Detail Window: Consoles at Channel on page 55

3.5.71

Conventional Channel Viewer Detail Window: Selected Conventional
Channel Information

Table 18: Conventional Channel Viewer Detail Window: Selected Conventional Channel Information

Field

Description

Conv Chan Num

Read-only field — displays the channel ID.

Conv Site ID

Read-only field — displays a unique number that refers to a specific conven-
tional site.

Conv Site Alias

Read-only field — displays a unique name that refers to a specific site.

Conv Chan Zone
ID

Read-only field — displays the zone ID of channel

Cons Sites

Read-only field — displays the total number of console sites.

Cons

Read-only field — displays the total number of consoles/console users.

Chan Group ID

Read-only field — displays the identification number of the channel group.

54

Send Feedback


http://docsurvey.motorolasolutions.com

MNO004281A01-A
Chapter 3: Affiliation Display Reference

3.5.7.2
Conventional Channel Viewer Detail Window: Console Sites at Channel

Table 19: Conventional Channel Viewer Detail Window: Console Sites at Channel

Field Description
Cons Site Alias Read-only field — displays a unique name that refers to a specific console
site.

E/ NOTICE: For foreign consoles 2 aliases separated with a colon (")
are displayed: console alias and alias of the foreign system.

Cons Site ID Read-only field — displays a unique number that refers to a specific console
site.

E/ NOTICE: For foreign consoles ID consists of console ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Cons Read-only field — displays the total number of consoles/console users which
are currently affiliated to the selected console site.

3.5.7.3
Conventional Channel Viewer Detail Window: Consoles at Channel

Table 20: Conventional Channel Viewer Detail Window: Consoles at Channel

Field Description

Cons Alias Read-only field — displays a unique name that refers to a specific console.

E/ NOTICE: For Analog Conventional, it displays a console alias but
for ASTRO® 25 Conventional it displays console user alias. For for-

eign consoles 2 aliases separated with a colon (“”) are displayed:
console alias and alias of the foreign system.

Chan Num Read-only field — displays the number of channels a console is affiliated to.

Cons Site Alias Read-only field — displays a unique name that refers to a specific console
site.

Cons Site ID Read-only field — displays a unique number that refers to a specific console
site.

Date Read-only field — displays the date of the last affiliation or deaffiliation of the

console to this conventional channel.

3.6
Radio Viewer

The Radio Viewer displays current affiliation information for one or more radios.
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Figure 7: Radio Viewer Display Window
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Tables in the following sections describe the different areas of the Radio Viewer display window:
* Radio Viewer Toolbar on page 56

» Radio Viewer Fields: Selected Radio Information on page 57

» Radio Viewer Fields: Talkgroups for Radio on page 58

* Radio Viewer Menu Bar on page 58

* Radio Viewer Pop-up Menu on page 59

* Radio Locator Window on page 60

* Radio Viewer Detail Window on page 62

3.6.1
Radio Viewer Toolbar

Q Graph

The pie chart shows the approximate percentage of all currently affiliated radios versus the number
of radios stored in the zone database. The area in yellow shows the percentage of radios with
known affiliation status; the area in red shows the percentage of radios with unknown affiliation
status.

Text Box
Used for entering radio IDs and aliases in the viewer.

Combo Box
Used for choosing the system. Choose the system with the radio you want to add.

+ Add Entry
Adds the radio ID or alias entered in the text box.

Remove Entry
Removes a selected radio ID or alias from the viewer window.

@. Locate Radio

Opens the Radio Locator window, displaying affiliation information for a selected radio.
i\'\'.' .
et View Talkgroups

When you click it, the Talkgroup for Radio section fills with the list of talkgroups for the selected
radio. If the selected entry/radio is affiliated only to the one talkgroup, this icon is not active.
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Opens the Detail Window for a selected radio.

3.6.2

Radio Viewer Fields: Selected Radio Information

Table 21: Radio Viewer Fields: Selected Radio Information

Field Description

Radio Type Read-only field — displays the type of the radio which is affiliated in the sys-

tem.

Radio Alias Read-only field — displays a unique name that refers to a specific radio.
NOTICE: For foreign radios 2 aliases separated with a colon (*:”)
are displayed: radio alias and alias of the foreign system. For in-
stance, a radio RD1 from the foreign system OHIO displays as
“RD1:0HIO".

Radio Id Read-only field — displays a unique number that refers to a specific radio.

E/ NOTICE: For foreign radios ID consists of radio ID, “:SYS:” prefix,
WACN ID (5 hexadecimal digits), dash (“-”), and System ID (3 hexa-
decimal d|g|ts) For instance, a radio 1281 from foreign system
01AF6-002 displays as “1281:SYS:01AF6-002".

Tgs Read-only field — displays the number of the talkgroup to which the radio is

currently affiliated.

Talkgroup Alias

Read-only field — displays a unique name that refers to a specific talkgroup.

E/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:7) are displayed: talkgroup alias and alias of the foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
IZ/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).
Site Alias Read-only field — displays a unique name that refers to a specific site.
Site Id Read-only field — displays a unique number that refers to a specific site.
Date Read-only field — displays the date of the last affiliation or deaffiliation by the

radio.

Current Status

Read-only field — displays the last known status of the radio.

TDMA capable radios that are affiliated to non-GTR 8000/GCP 8000 sites appear to the affiliation

display application as FDMA-only capable radios regardless of the true radio TDMA capability. This
means that TDMA capable radios at non-GTR/GCP sites do not appear in bold text despite the fact
that these radios are actually TDMA capable. This operation is because only GTR/GCP site equipment
understands the TDMA capability flag in the radio registration messages.

The dark blue, bold font used in the Radio Alias and Radio ID panes indicates the TDMA/FDMA

capable radio.

With the dynamic transcoding disabled in your system, the dark blue, bold font with white background
used in the Talkgroup ID and Talkgroup Alias columns indicates that the talkgroup operates as TDMA.
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FDMA is listed as black text with white background. With the dynamic transcoding enabled, there is no
visual difference between TDMA and FDMA operated talkgroups.

3.6.3

Radio Viewer Fields: Talkgroups for Radio

This pane and View Talkgroups button are active only for console sites/radios which are affiliated to
more than one talkgroup. If the console site or a radio is affiliated only to one talkgroup, this field is not
active and talkgroup information is displayed in the Selected Radio Information pane.

Table 22: Radio Viewer Fields: Talkgroups for Radio

Field Description

Talkgroup Alias

Read-only field — displays a unique name that refers to a specific talkgroup.

E/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(

“,n

.") are displayed: talkgroup alias and alias of foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
E/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).
3.6.4

Radio Viewer Menu Bar

Table 23: Radio Viewer Menu Bar

Menu Option Drop-down Option Description
File Close Closes the currently selected window.
Exit Closes the application.
View Console Site Convention- Opens the Console Site Conventional Viewer.
al Viewer
Conventional Channel Opens the Conventional Channel Viewer.
Viewer
Radio Viewer Opens the Radio Viewer.
Site Viewer Opens the Site Viewer.
Talkgroup Viewer Opens the Talkgroup Viewer.
Entries Add Entry Adds a new radio to the Radio Viewer.
Remove Entry Removes a selected radio from the Radio
Viewer window.
Locate Radio Displays information for selected radios.
View Talkgroups Displays information for talkgroups to which se-
lected radios are added.
Detail Window Opens a Detail Window.
Table continued...
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Menu Option Drop-down Option

Description

Window Affiliation Display

Displays the Affiliation Display window.

Site Viewer

Displays the Site Viewer, if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Console Site Convention-
al Viewer

Displays the Console Site Conventional Viewer,
if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Conventional Channel
Viewer

Displays the Conventional Channel Viewer, if it
is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Radio Viewer

Displays the Radio Viewer, if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Talkgroup Viewer

Displays the Talkgroup Viewer, if it is open.

To use this function, the window associated
with this option must already be open in the Af-
filiation Display. To open a window, use the
View menu from the Affiliation Display.

Help Help Topics

Opens the online help.

About Affiliation Display

Opens a About Affiliation Display window that
provides information about the application.

3.6.5
Radio Viewer Pop-up Menu

The following pop-up menu opens when you right-click the entry in the Selected Radio Information list

of the Radio Viewer:

Table 24: Radio Viewer Pop-up Menu

Menu Option Description

Remove Entry

Removes a selected entry from the Radio Viewer window.

View Talkgroups

Displays information for all available talkgroups for the selected radio.

Detail Window

Opens the Detail Window, which shows information about talkgroups and site
in which a radio is affiliated.
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3.6.6

Radio Locator Window

The Radio Locator Window displays the site and talkgroup affiliation information for a selected radio.
Figure 8: Radio Locator Display Window
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Tables in the following sections describe the different fields of the Radio Locator window:
» Radio Locator Window Fields: Requested Radio Information on page 60
» Radio Locator Detail Window Fields: Talkgroups for Radio on page 61

3.6.6.1
Radio Locator Window Fields: Requested Radio Information

TDMA capable radios that are affiliated to non-GTR 8000/GCP 8000 sites appear to the affiliation
display application as FDMA-only capable radios regardless of the true radio TDMA capability. This
means that TDMA capable radios at non-GTR/GCP sites will never appear in bold text despite the fact
that these radios are actually TDMA capable. This operation is only because GTR/GCP site equipment
understands the TDMA capability flag in the radio registration messages.

The dark blue, bold font used in the Radio Alias and Radio ID panes indicates the TDMA/FDMA
capable radio.

With the dynamic transcoding disabled in your system, the dark blue, bold font with white background
used in the Talkgroup ID and Talkgroup Alias columns indicates that the talkgroup operates as TDMA.
FDMA is listed as black text with white background. With the dynamic transcoding enabled, there is no
visual difference between TDMA and FDMA operated talkgroups.

Table 25: Radio Locator Window Fields: Requested Radio Information

Field Description
Radio Type Read-only field — displays the type of the radio.
Radio Alias Read-only field — displays a unique name that refers to a specific radio.

E/ NOTICE: For foreign radios 2 aliases separated with a colon (*:")
are displayed: radio alias and alias of the foreign system. For in-
stance, a radio RD1 from the foreign system OHIO displays as
“RD1:0HIO”.

Radio Id Read-only field — displays a unique number that refers to a specific radio.

IZ/ NOTICE: For foreign radios ID consists of radio ID, “:SYS:” prefix,
WACN ID (5 hexadecimal digits), dash (“-”), and System ID (3 hexa-
decimal digits). For instance, a radio 1281 from foreign system
01AF6-002 displays as “1281:SYS:01AF6-002".

Tgs Read-only field — displays the number of talkgroups for the selected entry.

Table continued...
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Field Description

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

E/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:”) are displayed: talkgroup alias and alias of foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
E/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Site Alias Read-only field — displays a unique name that refers to a specific site.

Site Id Read-only field — displays a unique number that refers to a specific site.

Date Read-only field — displays the date of the last affiliation or deaffiliation by the
radio.

Current Status Read-only field — displays the last known status of the radio.

Close Button Closes the Radio Locator window.

3.6.6.2

Radio Locator Detail Window Fields: Talkgroups for Radio

This pane is active only for console sites/radios which are affiliated to more than one talkgroup. If the
console site or radio is affiliated only to one talkgroup, this field is not active and talkgroup information
is displayed in the Requested Radio Information pane.

Table 26: Radio Locator Detail Window Fields: Talkgroups for Radio

Field Description

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

NOTICE: For foreign talkgroups 2 aliases separated with a colon
4
(“:7) are displayed: talkgroup alias and alias of foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
IZ/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).
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3.6.7
Radio Viewer Detail Window

Figure 9: Radio Viewer Detail Window
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Tables in the following sections describe the different fields of the Radio Viewer Detail Window:
» Radio Viewer Detail Window Fields: Selected Radio Information on page 62
» Radio Viewer Detail Window Fields: Talkgroups for Radio on page 63

3.6.71
Radio Viewer Detail Window Fields: Selected Radio Information

TDMA capable radios that are affiliated to non-GTR8000/GCP8000 sites appear to the affiliation
display application as FDMA-only capable radios regardless of the true radio TDMA capability. This
means that TDMA capable radios at non-GTR/GCP sites never appear in bold text despite the fact that
these radios are actually TDMA capable. This operation is only because GTR/GCP site equipment
understands the TDMA capability flag in the radio registration messages.

The dark blue, bold font used in the Radio Alias and Radio ID panes indicates the TDMA/FDMA
capable radio.

With the dynamic transcoding disabled in your system, the dark blue, bold font with white background
used in the Talkgroup ID and Talkgroup Alias columns indicates that the talkgroup operates as TDMA.
FDMA is listed as black text with white background. With the dynamic transcoding enabled, there is no
visual difference between TDMA and FDMA operated talkgroups.

Table 27: Radio Viewer Detail Window Fields: Selected Radio Information

Field Description
Radio Type Read-only field — displays the type of the radio.
Radio Alias Read-only field — displays a unique name that refers to a specific radio.

IZ/ NOTICE: For foreign radios 2 aliases separated with a colon (*:”)
are displayed: radio alias and alias of the foreign system. For in-
stance, a radio RD1 from the foreign system OHIO displays as
“RD1:0HIO".

Radio Id Read-only field — displays a unique number that refers to a specific radio.

Table continued...
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Field Description

E/ NOTICE: For foreign radios ID consists of radio ID, “:SYS:” prefix,
WACN ID (5 hexadecimal digits), dash (“-"), and System ID (3 hexa-
decimal digits). For instance, a radio 1281 from foreign system
01AF6-002 displays as “1281:SYS:01AF6-002".

Tgs Read-only field — displays the number of talkgroups for the selected entry.

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

IZ/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:”) are displayed: talkgroup alias and alias of the foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
E/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”

prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Site Alias Read-only field — displays a unique name that refers to a specific site.

Site Id Read-only field — displays a unique number that refers to a specific site.

Date Read-only field — displays the date of the last affiliation or deaffiliation by the
radio.

Current Status Read-only field — displays the last known status of the radio.

3.6.7.2

Radio Viewer Detail Window Fields: Talkgroups for Radio

Table 28: Radio Viewer Detail Window Fields: Talkgroups for Radio

Field Description

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

: For foreign talkgroups 2 aliases separated with a colon
Vs NOTICE: For foreign talk 2ali ted with I
:”) are displayed: talkgroup alias and alias of the foreign system.
(") displayed: talk li d alias of the forei t

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
|:/: NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

3.7
Site Viewer

The Site Viewer displays current affiliation information for one or more sites.
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Figure 10: Site Viewer Display Window
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Tables in the following sections describe the different areas of the Site Viewer display window:
» Site Viewer Toolbar on page 64

» Site Viewer Fields: Selected Site Information on page 65

» Site Viewer Fields: Talkgroups at Site on page 65

» Site Viewer Fields: Radios at Site on page 66

« Site Viewer Menu Bar on page 67

3.7.1
Site Viewer Toolbar

O Graph

The pie chart shows the approximate percentage of all currently affiliated radios versus the number
of radios stored in the zone database. The area in yellow shows the percentage of radios with
known affiliation status; the area in red shows the percentage of radios with unknown affiliation
status.

Text Box
Used for entering site IDs and aliases in the viewer.

+ Add Entry
Adds the site ID or alias entered in the text box.
R
"+ Request to have all available Sites displayed
Displays information for all available sites in the zone.
0 I‘nch-
T'dll Graph Sites
Opens the graph that shows a bar graph of the talkgroups and radios at a selected site.

Remove Entry
Removes a selected site ID or alias from the viewer window.

h\'.' .
ie.  View Talkgroups
Displays information for all available talkgroups at a selected site.

64 Send Feedback


http://docsurvey.motorolasolutions.com

MNO004281A01-A
Chapter 3: Affiliation Display Reference

EEE View Radios
Displays information for all available radios at a selected site.

Detail Window

Opens the Detail Window, showing the radios and talkgroups affiliated to a selected site.

b
ik
il Graph Talkgroups
Opens the graph window, showing a bar graph of the radios affiliated to one or more talkgroups at a
selected site.

This button is active when View Talkgroups from the Site Viewer Entries menu has been selected
and a list of Talkgroups appeared in the Site Viewer Talkgroups list.

3.7.2
Site Viewer Fields: Selected Site Information

Table 29: Site Viewer Fields: Selected Site Information

Field Description

Site Type Read-only field — displays site type information.

Site Alias Read-only field — displays a unique name that refers to a specific site.

Site Id Read-only field — displays a unique number that refers to a specific site.

Tgs Read-only field — displays the number of talkgroups affiliated with the selec-
ted site.

Affs Read only field — displays the number of all affiliations in the selected site.

Radios Read-only field — displays the number of radios affiliated with the selected
site.

3.7.3

Site Viewer Fields: Talkgroups at Site

Table 30: Site Viewer Fields: Talkgroups at Site

Field Description

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

IZ/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:”) are displayed: talkgroup alias and alias of the foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
E/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Radios Read-only field — displays the number of radios affiliated in the selected talk-
group.

Send Feedback 65


http://docsurvey.motorolasolutions.com

MNO004281A01-A
Chapter 3: Affiliation Display Reference

3.7.4
Site Viewer Fields: Radios at Site

TDMA capable radios that are affiliated to non-GTR 8000/GCP 8000 sites appear to the affiliation
display application as FDMA-only capable radios regardless of the true radio TDMA capability. This
means that TDMA capable radios at non-GTR/GCP sites never appear in bold text despite the fact that
these radios are actually TDMA capable. This operation is only because GTR/GCP site equipment
understands the TDMA capability flag in the radio registration messages.

The dark blue, bold font used in the Radio Alias and Radio ID panes indicates the TDMA/FDMA
capable radio.

With the dynamic transcoding disabled in your system, the dark blue, bold font with white background
used in the Talkgroup ID and Talkgroup Alias columns indicates that the talkgroup operates as TDMA.
FDMA is listed as black text with white background. With the dynamic transcoding enabled, there is no
visual difference between TDMA and FDMA operated talkgroups.

Table 31: Site Viewer Fields: Radios at Site

Field Description
Radio Type Read-only field — displays the type of the radio.
Radio Alias Read-only field — displays a unique name that refers to a specific radio.

E/ NOTICE: For foreign radios 2 aliases separated with a colon (“:")
are displayed: radio alias and alias of the foreign system. For in-
stance, a radio RD1 from the foreign system OHIO displays as
“‘RD1:0HIO".

Radio Id Read-only field — displays a unique number that refers to a specific radio.

E/ NOTICE: For foreign radios ID consists of radio ID, “:SYS:” prefix,
WACN ID (5 hexadecimal digits), dash (“-"), and System ID (3 hexa-
decimal digits). For instance, a radio 1281 from foreign system
01AF6-002 displays as “1281:SYS:01AF6-002”.

Tgs Read-only field — displays a number of talkgroups in which the radio is affili-
ated.
Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

: For foreign talkgroups 2 aliases separated with a colon
Vs NOTICE: For foreign talk 2 ali ted with [
:") are displayed: talkgroup alias and alias of foreign system.
“r displayed: talk li d alias of forei t

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
E/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”

prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Date Read-only field — displays the date of the last affiliation or deaffiliation by the
radio.
Current Status Read-only field — displays the last known status of the radio.
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Menu Option Drop-down Option Description
File Close Closes the currently selected window.
Exit Closes the application.
View Console Site Convention- Opens the Console Site Conventional Viewer.
al Viewer
Conventional Channel Opens the Conventional Channel Viewer.
Viewer
Radio Viewer Opens the Radio Viewer.
Site Viewer Opens the Site Viewer.
Talkgroup Viewer Opens the Talkgroup Viewer.
Entries Add Entry Adds the site ID or alias entered in the text box.
All Sites Displays information for all available sites in the
zone.
Graph Sites Opens the graph window, showing a bar graph of
the talkgroups and radios at a selected site.
Remove Entry Removes a site ID or alias from the viewer win-
dow.
View Talkgroups Displays information for all available talkgroups at
a selected site.
View Radios Displays information for all available radios at a
selected site.
Detail Window Opens the Detail Window, showing the radios and
talkgroups affiliated to a selected site.
Graph Talkgroups Opens the graph window, showing a bar graph of
the radios affiliated to one or more talkgroups at a
selected site.
Window Site Viewer Displays the Site Viewer, if it is open.

To use this function, the window associated with
this option must already be open in the Affiliation
Display. To open a window, use the View menu
from the Affiliation Display.

Affiliation Display

Displays the Affiliation Display window.

Console Site Convention-
al Viewer

Displays the Console Site Conventional Viewer, if
it is open.

To use this function, the window associated with
this option must already be open in the Affiliation
Display. To open a window, use the View menu
from the Affiliation Display.

Send Feedback

Table continued...

67


http://docsurvey.motorolasolutions.com

MNO004281A01-A
Chapter 3: Affiliation Display Reference

Menu Option Drop-down Option

Description

Conventional Channel
Viewer

Displays the Conventional Channel Viewer, if it is
open.

To use this function, the window associated with
this option must already be open in the Affiliation
Display. To open a window, use the View menu
from the Affiliation Display.

Radio Viewer

Displays the Radio Viewer, if it is open.

To use this function, the window associated with
this option must already be open in the Affiliation
Display. To open a window, use the View menu
from the Affiliation Display.

Talkgroup Viewer

Displays the Talkgroup Viewer, if it is open.

To use this function, the window associated with
this option must already be open in the Affiliation
Display. To open a window, use the View menu
from the Affiliation Display.

Help Help Topics

Opens the online help.

About Affiliation Display

Opens an About Affiliation Display window, that
provides information about the application.

3.7.6
Site Viewer Pop-up Menu

The following pop-up menu opens when you right-click any entry inside the Site Viewer:

Table 33: Site Viewer Pop-up Menu

Menu Option Description

Remove Entry Removes a selected entry from the Site Viewer window.

View Talkgroups Displays information for all available talkgroups at a selected site.

View Radios Displays information for all available radios at a selected site.

Detail Window Opens the Detail Window, showing the radios and talkgroups affiliated to a

selected site.

3.7.7
Site Viewer Detail Window

The Detail Window displays talkgroup and radio affiliation information for a selected site.
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Figure 11: Site Viewer Detail Window
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Tables in the following sections describe the different fields of the Site Viewer Detail Window:

» Talkgroup Viewer Fields: Selected Site Information on page 69

» Site Viewer Detail Window Fields: Talkgroups at Site on page 69

» Site Viewer Detail Window Fields: Radios at Site on page 70

3.7.71

Talkgroup Viewer Fields: Selected Site Information

Table 34: Talkgroup Viewer Fields: Selected Site Information

Field Description

Site Type Read-only field — displays the site type information.

Site Alias Read-only field — displays a unique name that refers to a specific site.

Site Id Read-only field — displays a unique number that refers to a specific site.

Tgs Read-only field — displays the number of talkgroups affiliated with the selec-
ted site.

Affs Read only field — displays the number of all affiliations in the selected site.

Radios Read-only field — displays the number of radios affiliated to the selected talk-
group.

3.7.7.2

Site Viewer Detail Window Fields: Talkgroups at Site

Table 35: Site Viewer Detail Window Fields: Talkgroups at Site

Field Description

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

E/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:”) are displayed: talkgroup alias and alias of the foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.

Table continued...
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Field Description

IZ/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Radios Read-only field — displays the number of radios affiliated to a particular talk-
group.

3.7.7.3
Site Viewer Detail Window Fields: Radios at Site

TDMA capable radios that are affiliated to non-GTR 8000/GCP 8000 sites appear to the affiliation
display application as FDMA-only capable radios regardless of the true radio TDMA capability. This
means that TDMA capable radios at non-GTR/GCP sites never appear in bold text despite the fact that
these radios are actually TDMA capable. This operation is only because GTR/GCP site equipment
understands the TDMA capability flag in the radio registration messages.

The dark blue, bold font used in the Radio Alias and Radio ID panes indicates the TDMA/FDMA
capable radio.

With the dynamic transcoding disabled in your system, the dark blue, bold font with white background
used in the Talkgroup ID and Talkgroup Alias columns indicates that the talkgroup operates as TDMA.
FDMA is listed as black text with white background. With the dynamic transcoding enabled, there is no
visual difference between TDMA and FDMA operated talkgroups.

Table 36: Site Viewer Detail Window Fields: Radios at Site

Field Description

Radio Type Read-only field — displays the type of the radio.

Radio Alias Read-only field — displays a unique name that refers to a specific radio in the
system.

E/ NOTICE: For foreign radios 2 aliases separated with a colon (*:")
are displayed: radio alias and alias of the foreign system. For in-
stance, a radio RD1 from the foreign system OHIO displays as
“RD1:0HIO”.

Radio Id Read-only field — displays a unique number that refers to a specific radio.

E/ NOTICE: For foreign radios ID consists of radio ID, “:SYS:” prefix,
WACN ID (5 hexadecimal digits), dash (“-"), and System ID (3 hexa-
decimal digits). For instance, a radio 1281 from foreign system
01AF6-002 displays as “1281:SYS:01AF6-002".

Tgs Read-only field — displays a number of talkgroups in which the radio is affili-
ated.
Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

|:/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:”) are displayed: talkgroup alias and alias of foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.

Table continued...
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Field Description

E/ NOTICE: For foreign talkgroups ID consists of talkgroup ID, “:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Date Read-only field — displays the date of the last affiliation or deaffiliation by the
radio.

Current Status Read-only field — displays the last known status of the radio.

3.8

Talkgroup Viewer
The Talkgroup Viewer displays current affiliation information for one or more talkgroups.

Figure 12: Talkgroup Viewer Display Window
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Tables in the following sections describe the different areas of the Talkgroup Viewer display window:
» Talkgroup Viewer Toolbar on page 71

» Talkgroup Viewer Fields: Selected Talkgroup Information on page 72

» Talkgroup Viewer Fields: Sites at Talkgroup on page 73

» Talkgroup Viewer Fields: Radios at Talkgroup on page 73

» Talkgroup Viewer Menu Bar on page 74

3.8.1
Talkgroup Viewer Toolbar

Q Graph

Pie chart that shows the approximate percentage of all currently affiliated radios versus the number
of radios stored in the zone database. The area in yellow shows the percentage of radios with
known affiliation status; the area in red shows the percentage of radios with unknown affiliation
status.

Text Box
Used for entering talkgroup IDs and aliases in the viewer.

Combo Box
Used for choosing the system. Choose the system with the radio you want to add.
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+ Add Entry
Adds the talkgroup ID or alias entered in the text box.
b
ph
vi'dll Graph Talkgroups
Opens the graph window, showing a bar graph of the radios and sites in a zone that are affiliated to
each selected talkgroup.

Remove Entry
Removes a selected talkgroup ID or alias from the viewer window.
¥
™ View Sites
Displays information for all available sites in the zone associated with a selected talkgroup.

EEE View Radios
Displays information for all available radios affiliated to a selected talkgroup.

Detail Window

Opens the Detail Window , showing information for radios and sites affiliated to a selected
talkgroup.
o x'nch-
T'dll Graph Sites
Opens the graph window, showing a bar graph of the radios at each site in a zone affiliated to a
selected talkgroup.

3.8.2
Talkgroup Viewer Fields: Selected Talkgroup Information

TDMA capable radios that are affiliated to non-GTR 8000/GCP 8000 sites appear to the affiliation
display application as FDMA-only capable radios regardless of the true radio TDMA capability. This
means that TDMA capable radios at non-GTR/GCP sites never appear in bold text despite the fact that
these radios are actually TDMA capable. This operation is only because GTR/GCP site equipment
understands the TDMA capability flag in the radio registration messages.

The dark blue, bold font used in the Radio Alias and Radio ID panes indicates the TDMA/FDMA
capable radio.

With the dynamic transcoding disabled in your system, the dark blue, bold font with white background
used in the Talkgroup ID and Talkgroup Alias columns indicates that the talkgroup operates as TDMA.
FDMA is listed as black text with white background. With the dynamic transcoding enabled, there is no
visual difference between TDMA and FDMA operated talkgroups.

Table 37: Talkgroup Viewer Fields: Selected Talkgroup Information

Field Description

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

I:;/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:”) are displayed: talkgroup alias and alias of foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.

Table continued...

72 Send Feedback


http://docsurvey.motorolasolutions.com

MNO004281A01-A
Chapter 3: Affiliation Display Reference

Field Description
E/ NOTICE: For foreign talkgroups ID consists of talkgroup ID,"“:SYS:”
prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).
Sites Read-only field — displays the number of sites affiliated to the selected talk-
group.
Radios Read-only field — displays the number of radios affiliated to the selected talk-
group.
3.8.3

Talkgroup Viewer Fields: Sites at Talkgroup

Table 38: Talkgroup Viewer Fields: Sites at Talkgroup

Field Description

Site Type Read-only field — displays the site type information.

Site Alias Read-only field — displays a unique name that refers to a specific site.

Site Id Read-only field — displays a unique number that refers to a specific site.

Radios Read-only field — displays the number of radios affiliated to the selected talk-
group.

3.8.4

Talkgroup Viewer Fields: Radios at Talkgroup

Table 39: Talkgroup Viewer Fields: Radios at Talkgroup

Field Description
Radio Type Read-only field — displays the type of the radio.
Radio Alias Read-only field — displays a unique name that refers to a specific radio in the
system.
E/ NOTICE: For foreign radios 2 aliases separated with a colon (“:”)
are displayed: radio alias and alias of the foreign system. For in-
stance, a radio RD1 from the foreign system OHIO displays as
“RD1:0HIO".
Radio Id Read-only field — displays a unique number that refers to a specific radio.
E/ NOTICE: For foreign radios ID consists of radio ID, “:SYS:” prefix,
WACN ID (5 hexadecimal digits), dash (“-”), and System ID (3 hexa-
decimal digits). For instance, a radio 1281 from foreign system
01AF6-002 is as “1281:SYS:01AF6-002".
Tgs Read-only field — displays a number of talkgroups in which the radio is affili-
ated.
Site Alias Read-only field — displays a unique name that refers to a specific site.
Site Id Read-only field — displays a unique number that refers to a specific site.
Date Read-only field — displays the date of the last affiliation or deaffiliation by the

radio.
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Field

Description

Current Status

Read-only field — displays the last known status of the radio.

3.8.5

Talkgroup Viewer Menu Bar

Table 40: Talkgroup Viewer Menu Bar

Menu Option Drop-down Option Description
File Close Closes the currently selected window.

Exit Closes the application.

View Console Site Con- Opens the Console Site Conventional Viewer.

ventional Viewer

Conventional Chan- Opens the Conventional Channel Viewer.

nel Viewer

Radio Viewer Opens the Radio Viewer.

Site Viewer Opens the Site Viewer.

Talkgroup Viewer Opens the Talkgroup Viewer.

Entries Add Entry Adds the talkgroup ID or alias entered in the text box.

Graph Talkgroups Opens the graph window, showing a bar graph of the
radios and sites in a zone that are affiliated to each se-
lected talkgroup.

Remove Entry Removes a selected talkgroup ID or alias from the view-
er window.

View Sites Displays information for all available sites in the zone
associated with a selected talkgroup.

View Radios Displays information for all available radios affiliated to a
selected talkgroup.

Detail Window Opens the Detail Window , showing information for ra-
dios and sites affiliated to a selected talkgroup.

Graph Sites Opens the graph window, showing a bar graph of the
radios at each site in a zone affiliated to a selected talk-
group.

Window Affiliation Display Displays the Affiliation Display window.

Console Site Con-
ventional Viewer

Displays the Console Site Conventional Viewer, if it is
open.

To use this function, the window associated with this op-
tion must already be open in the Affiliation Display. To
open a window, use the View menu from the Affiliation
Display.

Conventional Chan-
nel Viewer

Displays the Conventional Channel Viewer, if it is open.

To use this function, the window associated with this op-
tion must already be open in the Affiliation Display. To

74
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Menu Option Drop-down Option Description
open a window, use the View menu from the Affiliation
Display.
Site Viewer Displays the Site Viewer, if it is open.

To use this function, the window associated with this op-
tion must already be open in the Affiliation Display. To
open a window, use the View menu from the Affiliation
Display.

Talkgroup Viewer Displays the Talkgroup Viewer, if it is open.

To use this function, the window associated with this op-
tion must already be open in the Affiliation Display. To
open a window, use the View menu from the Affiliation
Display.

Radio Viewer Displays the Radio Viewer, if it is open.

To use this function, the window associated with this op-
tion must already be open in the Affiliation Display. To
open a window, use the View menu from the Affiliation
Display.

Help Help Topics Opens the online help.

About Affiliation Dis-  Opens a About Affiliation Display window that provides
play information about the application.

3.8.6
Talkgroup Viewer Pop-up Menu

The following pop-up menu opens when you right-click inside the Talkgroup Viewer:

Table 41: Talkgroup Viewer Pop-up Menu

Menu Option Description

Remove Entry Removes a selected entry from the Talkgroup Viewer window.

View Sites Displays information for all sites in the zone associated with a selected talk-
group.

View Radios Displays information for all available radios affiliated to a selected talkgroup.

Detail Window Opens the Detail Window, showing the radios and sites affiliated to a selected
talkgroup.

3.8.7

Talkgroup Viewer Detail Window

The Detail Window displays talkgroup and radio affiliation information for a selected talkgroup.
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Figure 13: Talkgroup Viewer Detail Window
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Tables in the following sections describe different areas of the Talkgroup Viewer Detail Window:
» Selected Talkgroup Information on page 76

» Talkgroup Viewer Detail Window Fields: Sites at Talkgroup on page 77

» Talkgroup Viewer Detail Window Fields: Radios at Talkgroup on page 77

3.8.7.1
Selected Talkgroup Information

TDMA capable radios that are affiliated to non-GTR 8000/GCP 8000 sites appear to the affiliation
display application as FDMA-only capable radios regardless of the true radio TDMA capability. This
means that TDMA capable radios at non-GTR/GCP sites never appear in bold text despite the fact that
these radios are actually TDMA capable. This operation is only because GTR/GCP site equipment
understands the TDMA capability flag in the radio registration messages.

The dark blue, bold font used in the Radio Alias and Radio ID panes indicates the TDMA/FDMA
capable radio.

With the dynamic transcoding disabled in your system, the dark blue, bold font with white background
used in the Talkgroup ID and Talkgroup Alias columns indicates that the talkgroup operates as TDMA.
FDMA is listed as black text with white background. With the dynamic transcoding enabled, there is no
visual difference between TDMA and FDMA operated talkgroups.

Table 42: Talkgroup Viewer Detail Window Fields: Selected Talkgroup Information

Field Description

Talkgroup Alias Read-only field — displays a unique name that refers to a specific talkgroup.

IZ/ NOTICE: For foreign talkgroups 2 aliases separated with a colon
(“:”) are displayed: talkgroup alias and alias of the foreign system.

Tgld Read-only field — displays a unique number that refers to a specific talk-
group.
NOTICE: For foreign talkgroups ID consists of talkgroup ID,*“:SYS:”

prefix, WACN ID (5 hexadecimal digits), dash (“-”), and System ID
(3 hexadecimal digits).

Sites Read-only field — displays the number of sites affiliated to the selected talk-
group.

Radios Read-only field — displays the number of radios affiliated to the selected talk-
group.
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Talkgroup Viewer Detail Window Fields: Sites at Talkgroup

Table 43: Talkgroup Viewer Detail Window Fields: Sites at Talkgroup

Field Description

Site Type Read-only field — displays the site type.

Site Alias Read-only field — displays a unique name that refers to a specific site.

Site Id Read-only field — displays a unique number that refers to a specific site.
Radios Read-only field — displays the number of radios affiliated to a particular site.
3.8.7.3

Talkgroup Viewer Detail Window Fields: Radios at Talkgroup

Table 44: Talkgroup Viewer Detail Window Fields: Radios at Talkgroup

Field Description
Radio Type Read-only field — displays the type of the radio.
Radio Alias Read-only field — displays a unique name that refers to a specific radio in the
system.
E/ NOTICE: For foreign radios 2 aliases separated with a colon (“:")
are displayed: radio alias and alias of the foreign system. For in-
stance, a radio RD1 from the foreign system OHIO displays as
“‘RD1:0HIO".
Radio Id Read-only field — displays a unique number that refers to a specific radio.
E/ NOTICE: For foreign radios ID consists of radio ID, “:SYS:” prefix,
WACN ID (5 hexadecimal digits), dash (“-”), and System ID (3 hexa-
decimal digits). For instance, a radio 1281 from the foreign system
01AF6-002 is as “1281:SYS:01AF6-002".
Tgs Read-only field — displays a number of talkgroups to which the radio is affili-
ated.
Site Alias Read-only field — displays a unique name that refers to a specific site.
Site Id Read-only field — displays a unique number that refers to a specific site.
Date Read-only field — displays the date of the last affiliation or deaffiliation by the

radio.

Current Status

Read-only field — displays the last known status of the radio.
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